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READ ME FIRST

Welcome to Take Control of Upgrading to Tiger, version 1.0.

Upgrading to a new version of Mac OS X can be a daunting prospect,
but with some expert advice, you’ll be running Mac OS X 10.4 Tiger
in no time. This ebook eliminates the uncertainty and the confusion,
guiding you through every step of the process. This ebook was written
by Joe Kissell, edited by Tonya Engst, and published by TidBITS
Electronic Publishing.

You can contact TidBITS Electronic Publishing by sending email to
te-comments@tidbits.com and view the Take Control Web site and
catalog at http://www.takecontrolbooks.com/. You can read About
This Ebook to learn about the author, the publisher, and the Take
Control series. The title page contains copyright and legal info.

The price of this ebook is $5. If you want to share it with a friend,
please do so as you would with a physical book, meaning that if your
friend uses it regularly, your friend should buy a copy. The Help a
Friend button on the cover makes it easy for you to give your friend
a discount coupon.

We may offer free minor updates to this ebook. Click the Check for
Updates button on the cover to access a Web page that informs you
of any available or upcoming updates. On that page, you can also
sign up to be notified about updates via email.

WARNING!

If you use Adobe Acrobat Pro version 6 or 7, make sure your Web
Capture preference is set to view Web URLs in a Web browser before
checking for updates. To do so, choose Acrobat > Preferences, switch
to the Web Capture pane, and choose In Web Browser from the Open
Web Links pop-up menu.
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Onscreen Reading Tips

We carefully designed the Take Control ebooks to be read onscreen,
and although most of what you need to know is obvious, note the
following for the best possible onscreen reading experience:

 Blue text indicates links. You can click any item in the Table of
Contents to jump to that section. Cross-references are also links,
as are URLs and email addresses.

« Work with the Bookmarks tab or drawer showing so that you can
always jump to any main topic by clicking its bookmark.

« Find more tips at
http://www.takecontrolbooks.com/faq.html#readingi.

Printing Tips

Although our layout is aimed at making online reading an enjoyable
experience, we’ve made sure that printing remains a reasonable
option. Please review these tips before you print:

« Use the Check for Updates button on the cover to make sure you
have the latest version of the ebook and to verify that we don’t plan
to release a new version shortly. If you want to commit this ebook
to paper, it makes sense to print the latest possible version.

« Don’t throw out your PDF after you print! You must click the
Check for Updates button on the cover to get future updates. The
link must be accessed from the cover of your PDF.

« For a tighter layout that uses fewer pages, check your printer op-
tions for a 2-up feature that prints two pages on one piece of paper.
For instance, your Print dialog may have an unlabeled pop-up
menu that offers a Layout option; choose Layout, and then choose
2 from the Pages per Sheet pop-up menu. You may also wish to
choose Single Hairline from the Border menu.

« When printing on a color inkjet printer, to avoid using a lot
of color ink (primarily on the yellow boxes we use for tips and
figures), look for an option to print entirely in black-and-white.

 In the unlikely event that Adobe Acrobat or Adobe Reader can’t
successfully print this PDF, try Preview; several readers have
solved printing problems by using Preview.
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Basics

In reading this ebook, you may get stuck if you don’t know certain
basic facts about Mac OS X or if you don’t understand Take Control
syntax for things like working with menus or finding items in the
Finder. Please note the following:

« Path syntax: I occasionally use a path to show the location of a
file or folder in your file system. Path text is formatted in bold type.
For example, Tiger stores most utilities, such as Terminal, in the
Utilities folder. The path to Terminal is: /Applications/
Utilities/Terminal.

The slash at the start of the path tells you to start from the root
level of the disk. You will also encounter paths that begin with ~
(tilde), which is a shortcut for any user’s home directory. For
example, if a person with the user name joe wants to install fonts
that only he can access, he would install them in his ~/Library/
Fonts folder, which is just another way of writing /Users/joe/
Library/Fonts.

« Finding preference panes: I sometimes refers to Mac OS X
preferences that you may want to adjust. To change these system-
wide settings, open System Preferences by clicking its icon in the
Dock or choosing System Preferences from the Apple menu. You
access a particular preference pane by way of its icon, or the View
menu. For example, to see “the Displays preference pane,” you
would launch System Preferences and then click the Displays icon
or choose View > Displays. To see “the Color pane of the Displays
system preferences,” you would do the same thing, and then click
Color.

« Menus: When I describe choosing a command from a menu in
the menu bar, I use an abbreviated description. For example, the
abbreviated description for the menu command that creates a new
folder in the Finder is “File > New Folder.”
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INTRODUCTION

Upgrading your Mac’s operating system is a bit like removing your
house’s existing foundation to add a new garage underneath—
something that happens frequently here in San Francisco. In both
cases, the procedure is conceptually simple: set aside the parts you
want to keep; remove some old pieces; add some new pieces; replace
the original structure onto the new foundation; and reconnect all the
infrastructure that was severed in the process. Assuming all goes well,
the final product is more stable and has wonderful new features.

In the case of Mac OS X 10.4 Tiger, tens of thousands of pieces—the
files that make up the operating system and your data—must go into
just the right places with just the right settings. Ensuring that this
happens is the job of the installer application, which knows what
needs to go where. Apple wants you to think of the process as a simple
one: double-click the installer, answer a few easy questions, wait for
the installation to complete, and enjoy your new operating system.
And to their credit, Apple has made some wonderful improvements
in the Tiger installer that promise to eliminate many frustrations of
earlier upgrades. Many users will have just the sort of trouble-free
upgrade we all hope for.

Even so, a major system upgrade such as this one is a complex op-
eration with many potential pitfalls. Problems can and do occur.
Some users will find that they can’t complete the installation process
but won’t know why: Some will be unsure which options to choose,

or what effect they’ll have. Some will be unable to reboot their Macs
after the installer finishes. Some will be unable to print or access the
Internet. Some will lose important data, encounter software incom-
patibilities, or find that their peripherals no longer work. I've run into
all these problems and more at one time or another, and I want to
spare you such inconveniences.

I have performed hundreds of operating system installations and
upgrades, including, at last count, 42 of Tiger (no kidding). I've
learned how to prevent, solve, or work around most of the problems
that can occur, and I share that information here so that you will have
a fantastic experience upgrading your own computers to run Tiger.
This ebook is your anti-anxiety guide to every step of the process.
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TIGER UPGRADE QUICK START

This ebook contains a lot of details, not all of which you need to know.
But before upgrading, you should be familiar with the overall process.
Here’s a brief overview of the upgrade steps you should take:

Prepare to upgrade:

Make sure your computer can run Tiger. See Check Your Hardware
for Compatibility.

Make room for your new operating system. See Make Sure You
Have Enough Disk Space.

Decide which of the three upgrade methods (Upgrade Mac OS X,
Archive and Install, or Erase and Install) is best for you. See
Choose an Upgrade Method.

Turn off login items (a.k.a. startup items) to avoid certain software
incompatibilities. See Disable Login Items.

Back up before you go forward! See Back Up Your Data.

Avoid getting stuck without the capability to run Classic
applications. See Make Sure You Have a Mac OS g Installer.

Prepare your disk by checking for errors and possibly partitioning.
See Verify Your Hard Disk and Consider Partitioning Your Hard
Disk.

NoTe If you're upgrading from Mac OS 9, skip ahead to Upgrading from
Mac OS 9? for more information before proceeding.

Perform a customized upgrade:

Make some initial selections in the Tiger installer. See Select a
Destination and Select an Upgrade Method.

Be sure you have all (and only) the Tiger components you need.
See Choose Optional Software.

Proceed with the installation. See Have a Cup of Tea.

Perform basic setup tasks, and if appropriate, transfer files from a
backup drive. See Use Setup Assistant and Transfer your old data.
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After the upgrade:

Apply updates to Mac OS X and critical applications. See Run
Software Update.

Find missing features and avoid unpleasant surprises. See Set Up
Your Tiger Environment.

Restore missing files, applications, drivers, Unix software, and
login items. See Restore Missing Files and Appendix A: Software
Sources.

If your circumstances require it, reinstall Mac OS 9 to run Classic
applications. See Install Mac OS 9 for Classic (If Necessary).

Perform one final check to be sure your disk is still healthy. See
Verify Your Disk (Again).

Problems? If your computer isn’t working properly after the
upgrade, don’t panic. See Troubleshoot Upgrade Problems.
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CHECK YOUR HARDWARE FOR COMPATIBILITY

All currently shipping Macs, and most models sold within the past

5 years or so, can run Tiger. However, Apple’s new system require-
ments exclude certain models. In particular, not every computer that
can run Panther can also run Tiger.

NOTE Planning to use an external FireWire drive? Be sure to read Update

(or Disconnect) FireWire Hard Drives, later in this section.

Processor and FireWire Support

Tiger requires a PowerPC G3, G4, or G5 processor and built-in
FireWire. The FireWire requirement is new (Panther required only
built-in USB), and makes for a more awkward distinction between
which models support Tiger and which do not. Here’s the breakdown:

o eMac: all eMac models include FireWire.

« iBook: The first iBook model, released in 1999, had no FireWire
port. iBooks sold from mid-2000 on include FireWire.

« iMac: The slot-loading iMac DV, released in October 1999, was
the first iMac to include FireWire; earlier models, such as the tray-
loading Rev. A—D iMacs, have no FireWire ports and therefore
cannot run Tiger. FireWire ports appear on all iMac G4 and G5
models, and all iMac G3 models released since 2000.

e Mac mini: all Mac mini models include FireWire.

« PowerBook: The original (“Kanga”) PowerBook G3, which lacks
FireWire, cannot run Tiger; neither can the “Wallstreet” Power-
Book G3 or the “Lombard” PowerBook (Bronze Keyboard), for
the same reason. However, the “Pismo” PowerBook (FireWire)
includes FireWire, as do all Titanium and Aluminum G4 models.

« Power Mac: The original beige Power Macintosh G3 and the
Power Macintosh G3 All-In-One lack a FireWire port, but every
Power Mac G3, G4, and G5 from the blue & white G3 (released in
January 1999) onward has built-in FireWire.

Note that simply adding a FireWire card to an unsupported Mac
does not make it Tiger-compatible; the installer will refuse to run.
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CHOOSE AN UPGRADE METHOD

For users with an earlier version of Mac OS X already installed:, the
Tiger installer offers three upgrade options:

« Upgrade Mac OS X (the default upgrade method)
« Archive and Install
« FErase and Install.

You will select one of these methods later, when you run the installer
(see Perform a Customized Upgrade), but you should know about
them now, because the method you choose will determine some of the
other preparatory steps you must take. Most users will opt for the
default choice, assuming that Installer Knows Best. In an ideal world,
this would be the most painless upgrade. Unfortunately, with every
new system upgrade, some users who choose this method run into
serious problems—especially if they don’t prepare for it properly.

In Take Control of Upgrading to Panther, I recommended Archive
and Install (with some modifications) for most users. With Tiger,
however, Apple has added a new file transfer capability that makes
Erase and Install a more attractive option for many users—while

also presenting you with an array of potentially confusing options.
Ultimately, your choice of upgrade method will depend on your Mac
setup. Review the following descriptions, and then see Which Method
Is Right for You? for help deciding which one to use.

Upgrade Mac OS X

The default method, Upgrade Mac OS X, attempts to make the transi-
tion as simple as possible by leaving all your files, applications, and
settings in place. The installer replaces all the components of your old
Mac OS X installation with their Tiger equivalents, and deletes those
that are obsolete. Meanwhile, it leaves all user-installed files (includ-
ing preferences) intact.

tIf you install Tiger onto a volume that does not already have a Mac OS X
installation, the “Upgrade Mac OS X” choice becomes “Install Mac OS X.” This
option installs a clean copy of Tiger on the selected volume, but does not erase
any other files that may already be present there.
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DISABLE LOGIN ITEMS

The items that open automatically when a user logs in were originally
called (logically enough) login items. Under Panther, the name
changed to startup items, which was confusing because there are
entirely different items that launch on startup, before users log in,
that are also called startup items. Thankfully, Apple changed the
name back to login items in Tiger. By whatever name, though, you
should disable these before performing an upgrade (and re-enable
them later).

If you follow one of my recommended upgrade methods, the Apple
installer will helpfully try to reactivate all your login items. However,
if your login items include applications that are incompatible with
Tiger, you may experience crashes or other unexpected behavior on
your first boot. Although you can temporarily disable login items
during Tiger’s initial startup process, this may prevent the installation
from finishing. Therefore, I recommend disabling all login items
before installing Tiger, and reactivating them afterward.

NoTE I deliberately ordered this step before Back Up Your Data (next),
because if you perform an Erase and Install and permit the installer
to transfer your old files (as I recommend), you will in so doing copy
any login items from your backup onto your new Tiger system—
negating the value of disabling them in the first place. If, however,
you perform an Upgrade or Archive and Install (see Choose an
Upgrade Method, just previously), you may prefer to disable your
Login items after backing up so that your backup, should you need
to boot from it, will still contain your login items.

Because you will want to reactivate most or all of these items later, I
recommend writing down the names of your login items before dis-
abling them.

Tip The Login Items list may contain a few items you don’t recognize,
because the files are hidden inside application bundles. To be sure
you know exactly where all the files are located, move the mouse
pointer over each item to display its full path.
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BACK UP YOUR DATA

System upgrades, because they affect so many parts of your hard disk,
and at such a low level, are occasions when problems are especially
likely to occur. So I can’t emphasize this strongly enough: before up-
grading, back up your data. The time you spend now may save you
countless hours of frustration later.

Tip If your hard drive died today, would you be unable to get back to
work quickly? If someone stole your computer, would all your valu-
able files be lost forever? Tragedies such as these happen surprisingly
often. Learn how to minimize downtime and thoroughly protect your
photos, documents, and other important information by reading my
ebook Take Control of Mac OS X Backups.
http://www.takecontrolbooks.com/backup-macosx.html

If you already follow a regular backup regimen (good for you!), verify
that you have recently backed up all your important files, and test
your backup by seeing if you can successfully restore a few represen-
tative files. (For a list of the files to which you should pay particular
attention, see “Back Up Your Personal Files,” next.) If not, this is a
perfect time to start. A backup utility will make the process much
easier. Nearly every serious Mac geek I know (including myself) uses
EMC Dantz’s Retrospect for backups (http://www.dantz.com/), but
many other fine programs will do the job. (See my ebook on backups,
referenced in the tip just above, for other recommendations.)

Whether or not you already use a commercial utility for backups, I
recommend that before upgrading to Tiger, you also duplicate (or
“clone”) your entire hard disk—make a complete, bootable copy—just
to be safe. (This is especially important if you erase your disk when
installing Tiger.) See “Make a Duplicate” (a few paragraphs ahead) for
instructions.

Back Up Your Personal Files

If you always store data in its default location, most or all of your
personal files are somewhere in your home folder, located in /Users.
This includes documents, photos, movies, and music files as well as
preferences, fonts, AppleScripts, saved email, Address Book and iCal
entries, and many third-party preference panes—plus the items that
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MAKE SURE YOU HAVE A MAC OS 9 INSTALLER

Although Mac OS X supports a Classic environment that enables you
to run older Mac software, Mac OS 9 does not come with Tiger. If you
don’t already have Mac OS 9 installed, you must obtain it and install
it separately in order to run Classic applications under Tiger (though
Tiger functions perfectly well without it). Even if you do have Mac OS
9 installed, it will disappear if you choose to erase the volume that
holds it when you upgrade. Unless you're certain you won’t need the
Classic environment, or that you will preserve your Mac OS 9 System
Folder when you upgrade, make sure you have a CD, DVD, or disk
image containing a Mac OS 9 installer.

Your Macintosh most likely came with a Mac OS 9 installation CD,

a Software Install and Restore DVD, or an Additional Software and
Apple Hardware Test CD containing Mac OS 9—or you may have a
Mac OS g installation CD from the original version of Mac OS X. On
some Software Install and Restore DVDs, the installer, located at the
top level of the DVD, is called “Install Applications & Mac OS 9”; on
other discs, the installer is called “Install Applications & Classic
Support” or “Install Extra Software.” In any case, you can choose to
install Mac OS 9 without the other applications that came with your
computer.

You can install Mac OS 9 either before or after Tiger. Your Mac OS 9
System Folder can reside on the same volume as Mac OS X, but I
recommend installing it on a separate volume or partition. See
Consider Partitioning Your Hard Disk for guidance about creating an
extra partition, then see Install Mac OS g for Classic (If Necessary) for
details on the installation process itself.

Tip If your computer is capable of booting into Mac OS 9 and you wish to
keep that as an option, the volume that contains Mac OS 9 must also
have the appropriate disk drivers. See Consider Partitioning Your
Hard Disk, later in this ebook, for details.
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VERIFY YOUR HARD DISK

Before installing Tiger, you should check your disk for errors and re-
pair them if necessary. (You can skip this step if you are erasing the
volume you will be installing Tiger onto or if you will be partitioning
your hard disk.) To verify and repair your hard disk:

1. Insert the Tiger Install DVD, run the installer, and click the Restart
button when prompted.

2. When your computer restarts from the DVD, click through the
language selection screen, and then choose Utilities > Disk Utility.

3. From the list on the left, select the volume you wish to install Tiger
onto, and click the First Aid tab on the right.

4. Click Repair Disk and wait for the repair to complete. If Disk
Utility reports that it repaired any errors, click Repair Disk a
second time to verify that the disk has no further errors.

5. If Disk Utility reports errors it cannot repair, you must either use
a third-party utility to repair the error, or erase the volume before
installing Tiger. When it comes to disk utilities, I recommend that
you use AlSoft’s DiskWarrior
(http://www.alsoft.com/DiskWarrior/) or TechTool Pro from
MicroMat (http://www.micromat.com/).

Your hard disk should now be free of errors that would prevent a
successful upgrade. You can quit Disk Utility, if you have not already
done so, and proceed with the installation of Tiger.

Tip Even if Disk Utility reports no errors, you might consider using a
utility such as DiskWarrior before upgrading to Tiger. Third-party
utilities frequently find (and fix) problems that Disk Utility does not.
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CONSIDER PARTITIONING YOUR HARD D1sk

All Macs ship with a hard disk configured as a single large volume.
You can divide your disk into two or more smaller volumes or par-
titions, each of which appears as a separate disk. Partitioning is an
entirely optional step, and for many users, it’s more trouble than it’s
worth. Under certain circumstances, however, partitioning may be
valuable. Before deciding whether to partition a disk, be aware of
some pros, cons, and consequences.

Understand Why (or Why Not) to Partition a
Disk

No one, strictly speaking, must partition a disk. In fact, Tiger’s design
assumes that all your applications, documents, media files, and so on
reside on the same volume. Plus, Tiger itself and many major applica-
tions like to have plenty of “breathing room,” which they normally
assume will be on the startup volume. So by partitioning your disk
you may be setting yourself up for extra work to make everything
function correctly. Why go to that effort?

« Provide limited insurance against disk errors: After you
partition a disk, you can install an operating system on each vol-
ume. If your main system develops disk errors that prevent it from
booting correctly, simply restart from another partition to run a
disk utility or recover important files. Of course, in the case of a se-
vere error that affects the entire drive, this scheme will fail—and if
you have a bootable CD or DVD containing Disk Utility or another
repair tool, you can use that instead and save several gigabytes of
space on your drive.

« Separate system files from user-created files: Some people
keep all their documents, media files, and third-party applications
on a separate volume, so that, if necessary, they can erase the Mac
OS X volume and install a clean copy of the operating system with-
out much inconvenience. Separating user-created files in this way
can also simplify making backups, since you can instruct your
backup application to back up only the files on the extra partition,
rather than trying to pick out the files and folders you want from
the main volume.
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PERFORM A CUSTOMIZED UPGRADE

With your hardware checked, your data safely backed up, and plenty
of free disk space, it’s time to begin the upgrade. (If you're upgrading
from Mac OS 9, be sure to read Upgrading from Mac OS 9? first.)
Insert the Tiger DVD and double-click the Install Mac OS X icon. In
the window that appears, click the Restart button, and enter your
administrator password when prompted. Your computer restarts
from the DVD and the installer runs.

Tip In the unlikely event that your computer does not restart from the
DVD, try the Computer Won'’t Start Up from the DVD... steps in
“Troubleshoot Upgrade Problems.” This section also has tips for
solving a several problems you might encounter during installation.

The installer asks you to choose a language, and then it presents you
with an Introduction screen and a Software License Agreement. Click
your way through those screens.

Select a Destination

The next screen asks you to select which volume to install Tiger onto.
If you have only one volume, this is an easy choice; if you have mul-
tiple partitions and/or disks, be sure to select the correct one. The
installer tells you if the selected volume has sufficient disk space; if
not, it tells you how much more you need. (You can reduce this
amount by deselecting optional software packages in a moment.)
Then...

Stop!

Do not click Continue, do not pass Go, do not collect $200. Not even
if your disk has plenty of space. Before you go on to the next step,
click the Options button at the bottom of the window to display a
dialog where you can choose one of three upgrade methods discussed
just ahead (Figure 2). This choice is crucial to your future happiness!

NoTE If you use the Tiger upgrade DVD obtained through the Mac OS X
Up-to-Date program, you most likely can install Tiger only onto a
volume that already has some version of Mac OS X installed. If you
need to put Tiger on another volume, install Panther there first.
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RUN SOFTWARE UPDATE

Shortly after your computer starts up under Tiger for the first time,
Software Update should run automatically. If it does not, choose
Software Update from the Apple menu. Software Update checks if a
newer version of Mac OS X (or any of the software installed with it) is
available—and if so, offers to download and install it.

Depending on the specifics of your system, the choices available will
vary. In general, I recommend installing updates for all software you
use regularly, especially Tiger itself. Apple often releases system up-
dates (i.e., 10.4.x) in the weeks just following a major OS release in
order to fix significant bugs or limitations found in the initial version.
Before doing anything else with Tiger, make your system as stable as
possible by applying these updates.

TIP

If Software Update lists an update you can’t use (such as new ver-
sions of software for an iPod or iSight if you don’t own one), you can
prevent the update from reappearing in the list by selecting it and
choosing Update > Ignore Update.

Some Mac users feel anxious every time a software update appears,
having heard horror stories of half-baked releases that cause as many
problems as they fix. I won’t lie to you: major errors occasionally
sneak into system updates. But this happens rarely, and in most
cases, Apple resolves such problems promptly. In addition, a fair
number of errors that appear to be update-related are in fact the
result of existing problems on the user’s machine, minor issues such
as incorrect permissions, or even (gasp!) user error. I can’t guarantee
that a software update will never break something, but in my experi-
ence, the benefits of incremental updates overwhelmingly outweigh
the risks—especially if you maintain good backups.

NOTE

If you need to downgrade to an older version of Tiger (for example,
10.4.0) after installing an update (see How to Downgrade), be aware
that the Tiger Upgrade DVD does not permit an Archive and Install if
the installed version is newer than what’s on the DVD. You must use
the full retail version of the DVD (or a Software Restore disc), or else
do an Archive and Install of Panther first, and then upgrade to 10.4.x.
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SET UP YOUR TIGER ENVIRONMENT

Other ebooks in the Take Control series, such as Matt Neuburg’s Take
Control of Customizing Tiger, help you to get the most from the new
Finder, discover hidden features, and organize your working environ-
ment (http://www.takecontrolbooks.com/tiger-customizing.html).
However, you should be aware of a few things right away.

Spotlight Indexing

As soon as Tiger starts up the first time, Spotlight (Apple’s slick, new,
high-speed search tool) begins indexing all the files on all mounted
volumes. This process can take anywhere from a few minutes to se-
veral hours, depending on how many files you have. During this time,
you’ll notice a lot of disk activity, and you’ll see a pulsating dot in the
center of Spotlight’s magnifying glass icon on the right side of your
menu bar. (Clicking this icon while indexing is proceeding displays an
estimate of the time remaining.) You must wait for Spotlight to com-
plete this initial indexing pass before you can use its search features.
Thereafter, however, Spotlight will quickly and unobtrusively index
new or modified files in the background.

Missing Features?

Some of Mac OS X’s standard features have been renamed, reorga-
nized, or otherwise changed. Before you panic, read on:

« Bluetooth Serial Utility: The functions of the Bluetooth Serial
Utility have been reorganized and rolled into the Bluetooth prefer-
ence pane (click the Sharing tab to set up serial port services).

« Find: Pressing Command-F (or choosing File > Find) in the
Finder displayed a new Find window under earlier versions of
Mac OS X. Under Tiger, the Find command causes the frontmost
Finder window to switch into Find mode, with new toolbar icons
and window contents. This way of searching for files gives you
capabilities similar to the old method, but because it uses Spotlight
technology, you have even more options—and searches are much
faster than before.

- iDVD, iMovie, and iPhoto: Although Panther included copies
of iDVD, iMovie, and iPhoto, Tiger does not. (Your existing appli-
cations will be preserved—but you won’t automatically get a new
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RESTORE MISSING FILES

(Note: If you selected Upgrade Mac OS X as your installation method,
the next several pages do not apply to you. You can skip ahead to
Restore Login Items.)

As I mentioned earlier, whether you use Archive and Install (and its
Preserve Users and Network Settings option) or Erase and Install
(transferring user files, applications, and documents from a backup
volume), the installer does not copy all your old files. To some extent,
this is a good thing—many of the files not copied are the ones most
likely to cause problems after upgrading. If you were going to copy all
the old files anyway, you might as well have chosen Upgrade instead;
you gain little from Archive and Install or Erase and Install.

That said, many users will find that they need some of these items. To
complicate matters slightly, the list of files not copied into the active
system differs depending on whether you used Archive and Install or
Erase and Install. Here are a few prominent examples of missing files.

Not copied during Archive and Install or Erase and Install:

 Drivers for peripherals such as mice, scanners, and audio
equipment and other system enhancements packaged as kernel
extensions (located in /System/Library/Extensions)

« Any user-installed files inside /usr—including the entire /usr/
local directory, which may contain Unix software such as MySQL
(and its data)

« Files you may have modified inside /private/etc, such as
/private/etc/httpd/httpd. conf, the Apache config file

Copied during Erase and Install but not copied during
Archive and Install:

« Third-party preference panes that were installed in /Library/
PreferencePanes (as opposed to a user’s
~/Library/PreferencePanes folder)

« The /Library/CFMSupport folder, which contains components
needed for Palm synchronization

« The contents of /Library/Components, which may include files
required for utilities such as Typelt4Me and iGlasses
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UPGRADING FROM MAcC OS 9?

If Tiger is your first version of Mac OS X, much of what I've talked
about won’t apply to you, as your Mac has no existing Mac OS X files
or settings to be copied. Never fear, the upgrade path is easy—in some
ways easier than upgrading from a previous version of Mac OS X.

To upgrade from Mac OS 9, follow these steps:

1. As always, begin by backing up your entire hard disk to another
volume using the utility of your choice (see Back Up Your Data).
Carbon Copy Cloner is a Mac OS X-only utility, but Retrospect
works quite well under both operating systems.

2. Be sure your hardware is compatible (see Check Your Hardware
for Compatibility).

3. If you have a second bootable volume (or a bootable Mac OS 9
CD), start from that volume, run Disk First Aid, and use the Repair
Disk function. If not, after booting from the Tiger Install DVD,
click through the language selection screen and then run Disk
Utility by choosing Utilities > Disk Utility.

4. Figure out which volume you want to use for Tiger. You can install
Tiger on the same volume that contains Mac OS 9, and the install-
er automatically sets up Tiger to use your old System Folder as its
Classic environment. But read Consider Partitioning Your Hard
Disk to see if that option may be useful to you.

5. If you have not already done so, insert the first Tiger Install DVD,
double-click the installer icon, and click Restart.

6. When the installer reaches the Select Destination screen, choose
the volume you want to use for Tiger. If you're installing Tiger on
the same volume as Mac OS 9, click Continue to use the default
installation method. If Tiger is going onto a different volume, click
Options and choose Erase and Install.

7. When asked to choose an Installation Type, click Customize.
Review the section Choose Optional Software under “Perform
a Customized Upgrade” for details about optional software.

When the installation finishes, find yourself a good book (or ebook!)
to acquaint yourself with your new operating system.
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TROUBLESHOOT UPGRADE PROBLEMS

Even if you diligently followed all the instructions in this ebook, you
might encounter problems while upgrading. I can’t anticipate every
difficulty you may have (or provide solutions in every case), but here
are some of the most likely issues and how to deal with them.

Computer Won't Start Up from the DVD...

After launching the installer and restarting, if your computer will not
boot from the installation DVD, do this:

1. Shut down your computer and wait for a few seconds. If the DVD
was ejected, make sure it is free of smudges, scratches, and finger-
prints, and reinsert it.

2. Press the Power button, and immediately hold down the C key to
force the computer to boot from the DVD. If this doesn’t work...

3. Restart your computer, this time holding the Option key. Icons
representing each valid startup volume will appear on the screen.
Click the icon for the installation DVD, and then click the right
arrow. If this doesn’t work...

4. Shut down your computer, and then remove all peripherals, net-
work cables, and anything else attached to your computer except
the Apple-supplied keyboard, mouse, and display. (You may also
need to remove any third-party video and PCI card(s) and even, in
rare cases, extra RAM modules.) Then go back to Step 2 (and Step
3 if necessary). If this doesn’t work...

5. Zap your PRAM. To do this, restart, and immediately hold down
the Command, Option, P, and R keys. When you hear the second
startup chime, release the keys and immediately press the C key
as in Step 2. If this doesn’t work...

6. Contact Apple. Start with the Support section of the Apple Web
site; if that does not contain the help you need, contact AppleCare
(if applicable) or visit your local Apple Store for assistance.

You should be able to restart from the Tiger Install DVD by the time
you finish these steps.
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How TO DOWNGRADE

As wonderful as Tiger is, you might find it necessary to downgrade to
your old system at some point if:

« An essential application does not work under Tiger.
« You encounter frequent crashes or compatibility problems.
 Drivers for your third-party hardware are not available.

Reverting to an older system is never pleasant, but if you’ve followed
the instructions for backing up your old system, it can be relatively
straightforward. To perform a downgrade, follow the instructions
under the heading that best matches your situation.

Reverting to a Bootable Duplicate

If, before upgrading to Tiger, you created a clone of your old system
on another volume (as discussed under Back Up Your Data), follow
these steps:

1. If you modified any documents while working in Tiger, be sure
to save a copy of those documents onto another volume before
restoring your cloned system. Also, resist the temptation to leave
your Tiger Applications folder in place when restoring an earlier
system. Many of the updated applications will not run under
earlier systems.

2. Start up your computer from a volume other than the one contain-
ing Tiger. This can be the hard disk or partition where your cloned
system exists, a startup CD or DVD, or any other volume with a
valid Mac OS X system.

NoTe The following steps assume you're using Carbon Copy Cloner. Retro-
spect users, if you previously used the Duplicate feature to clone your
hard disk, click the Immediate tab, then click Duplicate once again
(rather than Restore) to copy your cloned volume back to its new
location. After restoring your volume, skip to Step 5.
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APPENDIX A: SOFTWARE SOURCES

If you want to be sure you have the latest and most compatible firm-
ware, drivers, and utilities for Tiger, use these download links to save
yourself some time.

FireWire hard drive firmware:

EZQuest:
http://www.ezq.com/helpdesk/index.php?t=answ&id=38

FireWire Depot: http://www.fwdepot.com/thestore/default.php

Firewire Direct:
http://www.firewiredirect.com/site/panther.shtml

Glyph: http://www.glyphtech.com/site/support_updates.html
LaCie: http://www.lacie.com/support/drivers/
Macpower: http://www.macpower.com.tw/news/2003/10/30/112

Other World Computing:
http://eshop.macsales.com/Reviews/Framework.cfm?page=/hard
wareandnews/oxford/oxfordandpanther.html

WiebeTech: http://www.wiebetech.com/techsupport.html

Audio & MIDI equipment drivers:

Apogee Electronics: http://www.apogeedigital.com/downloads/
Digidesign: http://www.digidesign.com/download/

Echo Digital Audio:
http://www.echoaudio.com/Downloads/Drivers.php

Edirol: http://www.edirol.com/support/drivers.html
Mark of the Unicorn: http://www.motu.com/

M-Audio (includes MIDIMan):
http://www.m-audio.com/index.php?do=support.drivers

Novation: http://www.novationmusic.com/downloads.asp

RME Intelligent Audio Solutions:
http://www.rme-audio.de/english/mac/osx96.htm
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